
Chapter. 14
Association for Ordinal



If your variables are
“Group Ordinal Variables”…

• Strongly agree, agree, don’t know, disagree, 
strongly disagree…

• The basic logic is PRE (Proportional Reduction of 
Error)

• Gamma, Somer’s D, and Kendall Tau.
• The key idea, in addition to PRE, is the concept of 

“pairs.”



The Concept of Pairs

• Nc: pairs that display the same order on both X and 
Y (concordant)

• Nd: pairs that display the inverse order on X and Y 
(discordant)

• Eg. The higher the social class of parents, the 
higher the social class of offspring: Nc

• The higher the social class of parents, the lower the 
social class of offspring: Nd.



Nc and Nd



• (1,2) Nc
• (1,3) Nc
• (1,4) Tx (Pairs ties on X)
• (1,5) Nc
• (2,3) Ty (Pairs ties on Y)
• (2,4) Tx
• (2,5) Nc
• (3,4) Nd
• (3,5) Tx
• (4,5) Nd

Cases Parent Offspring

1
2
3
4
5

Lower
Upper
Med
Upper
Med

Lower
Upper
Upper
Lower
Med



Gamma

• Nc is the number of concordant pairs: 4
• Nd is the number of discordant pairs: 2

• Gamma is (4-2)/(4+2)=1/3=0.333…
• Positive relationship: It is more likely that two variables go 

with each other in the same direction.
• In terms of PRE, you can reduce the amount of error by 

33% when predicting offspring’s social class if you know 
about parents’ social class than if you don’t know.



Somer’s D

• Gamma does not care about tied pairs. Therefore, it 
sometimes overestimates the association. The 
number of tied pairs increases, Gamma is not that 
reliable.

• Somer’s D=(Nc-Nd)/(Nc+Nd+Ty)
• For the example above, Somer’s D is (4-

2)/(4+2+1)=0.286. 
• When there are no tied pairs, gamma is the same 

with Somer’s D.



Kendall Tau

• If there are many tied pairs, Kendall Tau is the most 
common because it considers both Tx and Ty. In 
other words, there are no tied pairs, then Gamma is 
the same with Kendall Tau.

• Kendall’s Tau b is defined:
[Nc-Nd]/sqrt[(Nc+Nd+Ty)(Nc+Nd+Tx)]



• Using SPSS is recommended. 
• Caution: You have got the crosstabulation, not raw 

data like GSS. So, you have to command SPSS to 
read 34, 114, 17… as frequency. (Recall the 
homework question 2 in chapter 10!)



• It is unavoidable to solve the subquestion (c) by 
hand! Again, if both increase in the same direction, 
then Nc; if both move in the opposite direction, then 
Nd; if X changes but Y does not, then called tied on 
Y; if Y changes but X does not, then called tied on X.



Basic Steps

• V1 is freq; V2 is death; V3 is school.
• For V2, favor is 1, and oppose is 2.
• For V3, from LT high school is 1… to graduate is 5.
• For example, in the data editor, 34 if a respondent 

is LT high school(1) and Favor(1). 12 if a 
respondent is graduate(5) and oppose(2).

• After inputting the data, don’t forget to go to 
Data>Weight cases!



Variable View Window



Input the data



Weight Cases



Analyze>Descriptive Statistics>
Crosstabs







If your variables are
“Full Rank Ordered”…

• Rank all of cases from highest to lowest.
• Spearman’s Rho. (from -1 to +1)
• This is not based on PRE principle: Unlike the first 

three, for example, even if Rho is 0.4, you cannot 
say that you are able to reduce the error by 40% 
with the help of independent variable when 
predicting dependent variable.



Strength and pattern

• If rho is +1, this means that high ranks on X are 
perfectly matched with high ranks on Y.

• If rho is -1, this means that high ranks on X are 
perfectly matched with low ranks on Y. (Inverse 
match)

• If rho is 0… there is no consistent agreement 
between cases in terms of their ranks.



Spearman rank-order 
correlation

• The equation: 

• D is the difference between corresponding ranks on 
X and Y; N is the total number of cases.

• H0: The correlation (or association) you observed is 
just because of sampling errors.

• H1: The correlation is not that small. Therefore, it is 
more likely that two variables are associated 
significantly with each other in the population.



Example.

X Y

38
35
40
30
33

19
10
24
17
13

Rank on X Rank on Y D D2

4
3
5
1
2

4
1
5
3
2

0
2
0
-2
0

0
4
0
4
0



Calculation and Interpretation

• What is N? 5 (not 10!)

• Rho=1-[6*(0+4+0+4+0)]/[5*(25-1)]=0.6
• What does this imply? 
• Again, three points: 1) statistical significance, 2) the 

strength of association, 3) direction of association.
• 1) You don’t know yet. 2) Relatively strong. 3) 

Positive (The rank of X goes with the rank of Y in 
the same direction)





How to know statistical 
significance?

• There is no table in your textbook.
• Rho is 0.6 and N is 5. If your confidence level is 95% 

and you are interested in two-tailed test, then CV is 1.00.
• Your test statistic falls outside the rejection region.
• In conclusion, the positive association we have got is 

not that large to be considered reliable.
• Caution: All of your test statistic except 1 will not help to 

reject the null. In this way, if your sample size is so 
small, the hypothesis test becomes very strict.



How to use SPSS
(Input ranks instead of scores!)



• Analyze>Correlate>Bivariate



How to calculate pairs
by hand?



This table is the same as your 
homework in terms of the size
(2 by 5) Just do the same way.

freshman sophomore junior senior graduates

Like 30 30 20 50 40

Dislike 60 70 60 80 120



Look for Nc! (Concordant pairs)

• Caution: Education 
level increases to 
the right side, from 
lower rank to 
higher rank.

• Favor decreases to 
the down, from 
higher rank (like) to 
lower rank (dislike)!

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Look for Nc! (Continued)

• What is concordant 
pairs? The same 
order on both 
variables.

• Let’s start with the 
grey cell (60).

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Look for Nc! (Continued)

• Focusing on the red 
cell, this and the 
starting cell are 
concordant since X 
increases from 
freshman to 
sophomore, and Y 
also from dislike to 
like.

• Therefore, the number 
of pairs is 60X30. 

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Look for Nc! (Continued)

• Focusing on another 
red cell, this and the 
starting cell are again 
concordant since X 
increases from 
freshman to junior, 
and Y also from 
dislike to like.

• In this case, the 
number of pairs is 
60X20. 

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Look for Nc! (Continued)
• In the same way, we 

can know another two 
cells and the starting 
cell are concordant 
since X increases 
from freshman to 
senior (graduates), 
and Y also from 
dislike to like.

• In this case, the 
number of pairs is 
60X50 and 60X40.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Look for Nc! (Continued)
• What is the next 

victim? Let’s start with 
the next cell (70).

• In the same way 
above, you can find 
three cells (red) that 
are concordant.

• Therefore, the number 
of pairs is 70X20, 
70X50, 70X40.

• What else? No.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Look for Nc! (Continued)
• Let’s move on to 

another next cell (60).
• In the same way 

above, you can find 
two cells (red) that are 
concordant in this 
time.

• The number of pairs is 
60X50, 60X40.

• What else? No.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Look for Nc! (Continued)
• Let’s move on to the 

last cell (80).
• In this time, there is 

only one cell (red) that 
is concordant.

• The number of pairs is 
80X40.

• In this way, you 
finished the number of 
Nc. To get the total 
number, just add up 
all of numbers so far.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Look for Nd! (Discordant)

• What is discordant 
pairs? The 
opposite order on 
both variables.

• Let’s start with the 
grey cell (30).

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Look for Nd! (Discordant)

• Looking at the red cell, 
X increases from 
freshman to 
sophomore, but Y 
decreases from like to 
dislike. This pair is 
none other than 
discordant!

• The number of pairs is 
30X70.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Look for Nd! (Discordant)

• Now, you can find out 
there are three more 
cells that are 
discordant. (red)

• The number of pairs is 
30X60, 30X80, 
30X120.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Look for Nd! (Discordant)

• Let’s move on to the 
next cell. For the new 
grey cell, you can 
realize there are three 
cells that are 
discordant. (red)

• The number of pairs is 
30X60, 30X80, 
30X120.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Look for Nd! (Discordant)

• For the new grey cell, 
in the same way 
above, the number of 
pairs is 20X80, 
20X120.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Look for Nd! (Discordant)

• For the new grey cell 
(50), in the same way 
above, the number of 
pairs is 50X120.

• This is the last cell.
• To get the total 

number of discordant 
cells, just sum up.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



What else remains?

• Let’s think about any 
other combinations 
we did not deal with 
so far.

• For the grey cell, we 
did not consider the 
following pairs (red) 
where X increases but 
Y remains as the 
same.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Ty (pairs tied on Y)

• These pairs are called 
“Pairs tied on Y”.

• The number of these 
pairs is 60X70, 60X60, 
60X80, 60X120.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



What else remains? (Continued)

• What else? There 
must be another 
relationship we did not 
care about so far.

• What about the 
relationship between 
the grey cell and the 
red? Y increases from 
dislike to like, but X is 
the same.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Tx (Pairs tied on X)

• These are called pairs 
tied on X.

• The number of Tx is 
60X30.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



In the same way, look for Tx and Ty

• For 70 in the second 
row, there are three 
pairs tied on Y. The 
number of pairs is 
70X60, 70X80, 
70X120.

• What is the number of 
pairs tied on X? 
70X30.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Continued…

• Just do the same with 
the cell (60), the cell 
(80).

• How about the last 
cell (120)? Because 
we have moved 
toward the right, there 
is no pair tied on Y. 
However, there is one 
pair tied on X. So, 
(40X120).

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Continued…

• Wow! Sooo boring. 
The next victim is the 
grey cell (30) again.

• However, you counted 
the relationship 
between this cell and 
the red just before.

• Therefore, just focus 
on four pairs tied on Y 
here.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Continued…

• In the same way, 
calculate only the 
number of three pairs 
tied on Y again.

• Why? You already 
counted the 
relationship between 
this cell and the red 
before.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120



Continued…

• Do the same with the cell 
(20), the cell (50).

• How about the last cell 
(40)?

• Since we have moved 
right, there is no pair tied 
on Y.

• You don’t need to count 
the number of pair tied on 
X because you already 
counted that.

fresh
man

soph
omor
e

juni
or

sen
ior

grad
uates

Lik
e

30 30 20 50 40

Dis
lik
e

60 70 60 80 120
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